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Abstract 
 

In 2015, International Christian University (ICU) became a Google 
Educational Domain with all users in the domain allocated a Gmail account 
and access to Google’s G-Suite for Education applications. The Center for 
Teaching and Learning (CTL) and instructors in the English for Liberal Arts 
program (ELA) have actively encouraged ICU instructors to take advantage of 
these applications, particularly Google Classroom, Docs, Forms, Sheets, and 
Slides. The purpose of this paper is to further stimulate interest in these 
applications by focusing on their efficiency and effectiveness in providing 
feedback on students’ written work, particularly the application Google 
Classroom, and three tools within Google Docs (Preferences, Voice typing, and 
Keep notepad). Using these digital tools has enabled instructors to significantly 
reduce the amount of time spent assessing written work while also facilitating 
providing students with higher quality of feedback.     

 
For most first-year students at ICU, the main focus of their study is on developing a 

high level of competence in academic English. This includes skill in academic reading, 
lecture listening, classroom discussions, and research writing. ICU’s English for Liberal Arts 
program is dedicated to developing these skills by providing an extensive English for 
Academic Purposes (EAP) curriculum that largely occupies most students’ first-year course 
load (and for most students includes a course in their second year as well). The aim is for 
these students to have acquired enough competence (and confidence) in their EAP skills that 
they can then move on to take regular university courses taught in English, either at ICU in 
the College of Liberal Arts (CLA) or on exchange programs at universities overseas.  

Acquiring this level of academic competence in English, however, is a significant 
challenge for the majority of Japanese students who have graduated from Japanese high 
schools. The development of academic writing skills, in particular, requires a tremendous 
amount of focused instruction by instructors, and dedicated practice by students. To prepare 
students for writing academic and research papers in English, first-year ELA students are 
assigned a variety of progressively more challenging writing tasks. In the Spring Term, this 
typically involves a paragraph, an academic reaction paper, and an essay of five paragraphs; 
in the Fall Term, two research-based essays (five paragraphs and eight paragraphs); and in the 
Winter Term, one longer research-based essay and one report. ELA instructors teach and 
support the development of these increasingly sophisticated writing skills through classroom 
instruction, one-on-one tutorials, repeated drafts, and continuous feedback. This feedback 
encourages the development of both technical writing skills such as organizational structure, 
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coherence, cohesion, and unity as well as providing students with greater self-awareness and 
autonomy as writers in an academic community.  

This process of feedback is essential for the first year ELA students to improve their 
technical EAP writing skills and build confidence in their writing. In their 2013 book, Visible 
Learning and the Science of How We Learn, Hattie and Yates explain that, “…receiving 
appropriate feedback is incredibly empowering. Why? Because it enables the individual to 
move forwards, to plot, plan, adjust, rethink and thus exercise self-regulation in realistic and 
balanced ways” (2013, p. 66). ELA instructor feedback is aimed at cultivating these kinds of 
processing skills, and facilitating the development of empowered, confident, and self-reliant 
academic writers. Instructors guide students in their understanding of what constitutes a well-
written paper and how continued revision results in better writing. This can only be done 
through cycles of feedback and multiple drafts. For each assignment, instructors may need to 
assess from two to four drafts from each student, which adds up to a significant number of 
drafts over the course of a term. Carefully reading and responding to these drafts requires an 
enormous amount of attention, time, and dedication. In the words of Nancy Sommers of 
Harvard University’s Graduate School of Education, a leading authority on the teaching of 
academic writing, “Reading drafts—and responding to student writers—takes up more time, 
thought, empathy and energy than any other aspect of teaching writing. We feel a weighty 
responsibility when we respond to our student’s words …” (2013, p. x). 

One of the tasks of the ELA writing instructor is to focus on the fundamentals of   
academic writing. Due to this, much of the initial feedback tends to be similar in nature 
because the student writers are at comparable levels of skill and understanding. This feedback 
is typically related to formatting, organizational structure, clarity of expression, appropriate 
tone, level of formality, etc. Before instructors can move on to address the more sophisticated 
and central elements of writing—the ideas, the development of argument, and the student’s 
creative approach and solution to a problem or question—these fundamental skills must be 
taught. Therefore, a pressing initial task for instructors is to quickly and efficiently provide 
students with feedback that addresses these fundamental skills, so that time is then available 
to help students develop the ideas and advancement of their arguments. One way in which 
instructors at ICU have been able to provide this kind of routine feedback effectively is 
through Google’s G-Suite for Education range of applications. 

G-Suite for Education is available for free to educators around the world and at all 
levels of education. G-Suite for Education is the official name for the range of digital 
applications that are offered within a Google Educational domain. These are essentially the 
same applications that are also offered outside a Google Educational domain: applications 
such as the Chrome browser, Gmail, Docs, Sheets, and Forms. There are some differences, 
however, and these can be very attractive to educators and educational institutions. One 
difference is that the G-Suite applications are isolated and protected from the advertising and 
data mining by which Google earns a majority of its revenue. This is ensured by independent, 
outside third-party organizations. Another difference is that G-Suite includes Google 
Classroom, a learning management and workflow system specifically designed to help 
teachers interact with their students. Classroom serves as a hub for the integration of Gmail 
and such applications as Docs, Sheets, Forms, etc. to create a seamless flow between 
instructor and student. From within Classroom, students can be contacted, tasks can be 
assigned, work can be shared, and assignments can be collected, assessed, graded, and 
returned. This makes for an ideal environment for the workflow in handling students’ writing 
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assignments. Students submit their drafts on Docs, instructors digitally respond to these 
drafts, and with a couple of clicks instructors return the drafts via a link within an email. This 
digital workflow offers a much more efficient and effective process than physically receiving 
and returning paper copies of written work.  
 
 

Working Within a Google Doc 
 
 Two additional advantages of the digital approach and using Google Docs to deliver 
feedback are clarity and the ability to review past work. When instructors provide handwritten 
comments on student paper drafts, the comments can sometimes be problematic for students 
to read. Instructors working with 40 to 50 hardcopy papers of 1000 words tend to write as 
quickly as possible. Such handwritten comments may be very difficult for students to read. 
Further, space is often limited and teachers tend to abbreviate the substance of the comment, 
again raising the possibility that students will find the comment difficult to understand and 
take action on. These problems are resolved when using a digital document for essay writing, 
and accordingly offering instructor feedback. Further, when using a paper system each new 
draft needs to be printed out again. In Google Docs, students have both the previous versions 
of their work saved for them in the revision history tool (under the File menu) as well as all of 
the previous teacher comments under the Comment tool. This allows students to quickly 
access previous versions of their work, and if they wish, to review teacher comments. This 
encourages student self-reflection and the view that writing is as much process as product.  

Google Docs offer the teacher of writing several other advantages in providing timely 
and effective feedback. Firstly, the documents can be shared with the teacher, allowing access 
to student work at any time. This facilitates the concept of Just-in-Time Teaching1 (JiTT) as 
instructors can view student work just before class, see where students are in terms of their 
writing, consider what would be effective to cover in the coming lesson, and to select 
appropriate materials from their materials bank in order to address any issues that have arisen. 
Secondly, the Editing mode of Google Docs has a “Suggestions” function, which clearly 
delineates in green any alterations to the student’s original text. Students then have the 
opportunity to either accept or reject the suggestion. This helps promote the concept of 
collaboration and a feeling of working together, rather than that of the teacher being the 
expert and “gatekeeper” as to what constitutes good written work. For students to become 
self-reliant writers, it is essential that they develop critical skills in analyzing their own work 
and the feedback from readers and reviewers.  

Providing written feedback on the papers, however, remains a time-consuming and 
labor-intensive task. Although many instructors feel it is easier to type on digital drafts (either 
directly into the text using the “Suggestions” mode or in comment boxes) than it is to write by 
hand on paper drafts, it is still time consuming and tedious, especially if the same comments 
must be made again and again. There are, however, three tools within any Google Doc that 
make it much easier for instructors to deliver such oft-repeated messages to their students. 
These are Preferences, Voice typing, and Keep notepad. Each of these will be explained in 
turn. 

                                                
1 Just-in-Time Teaching (JiTT) – a teaching strategy that uses feedback from tasks and work done out of the 
classroom to help teachers adjust class content to better suit their learners. 
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Preferences 
 

When using Preferences, the teacher is able to create a list of abbreviations for 
commonly used phrases. To access this tool, the instructor opens up the Google Doc Tools 
menu, then Preferences.  

 

 
 
The instructor types in the abbreviation in the Replace column and the sentence to be 

auto-generated in the With column.  
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Some examples that have been used in actual student feedback are listed below: 
 

ifr – i look forward to your next rewrite. 
cw – consider a different word here. 
teo – try to expand on this idea a little more. 
tnc – the thesis statement needs to more clearly express a position to be 
argued; please rethink this and see me if you need help. 

 
When the teacher types in the abbreviation and then pushes enter (PC) or return (Mac), the 
sentence is auto-generated. It is quick, easy, and there appears to be no limit to the length of 
the text that can be abbreviated.  

There are, however, a few issues that limit the potential of this tool. Firstly, the auto-
generated sentences do not start with capital letters. Online help communities suggest this is a 
common complaint (e.g. “ask Google to add this”) with as yet a solution. A second issue is 
that these auto-generated texts can only be inserted into the text of a Doc, and not into a 
comment box. For teachers who prefer to use the insert comments function to offer feedback, 
this represents another shortcoming of this tool.  
 
Voice Typing 
 

Instructors who are not proficient typists will especially appreciate the assistance 
offered by the application Voice typing. This can also be accessed from the Tools menu of 
any Google Doc. After clicking on Voice typing, a microphone appears. When ready to speak, 
click on the microphone and begin speaking. Your voice will be transcribed on the page.  

 

 
 
 
To use the tool, the computer’s internal microphone input must be activated. Other 

languages, including Japanese, are available to the user by clicking on the menu just above 
the microphone icon. For punctuation in English, simply tell Voice typing what is wanted. A 
common list of punctuation symbols and functions are listed below:  
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Period    → . 
Comma  → ,  
Exclamation point → ! 
Question mark             → ? 
New line   
New paragraph 

 
If the user speaks clearly, the tool works smoothly and efficiently. For Japanese 

speakers using Japanese, however, Voice typing currently does not offer punctuation. This 
slightly compromises the usefulness of this tool when working in the Japanese language.  
 
Keep Notepad 
 

Another important tool under the Tools menu of any Google Doc is Keep notepad. 
The Keep notepad tool is a recent development, having been derived from a Google 
standalone application simply called Keep. Keep is a web-based, cross-platform 
productivity/organizational app, first made available to Android devices in 2013 and to iOS 
devices in 2015. Most people familiar with the app use it for taking notes on their 
smartphones, but there is an integrated desktop counterpart as well. Notes can be made in the 
form of texts, images, and audio recordings. These notes can be shared and collaborated upon 
(e.g. a shopping list for the grocery store that is shared by spouses). Advanced features 
include reminders, tagging and searching notes, and optical character recognition of images. 
While known for its simplicity and minimalist interface, Keep can be used as an alternative to 
a much more sophisticated organizational application such as Evernote. Keep notepad, on the 
other hand, is a tool within Google Docs that came about with the integration of Keep with 
Google Docs in February 2017. 
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As a feedback tool, Keep notepad has enormous potential. This is because it is now 
possible to compile a sophisticated set of feedback notes within Keep that can be readily 
transcribed onto a student’s paper using Keep notepad. Click on Keep notepad and a sidebar 
opens on the right side of the Doc with whatever comments you have stored there. A teacher 
merely needs to choose from the list and copy and paste the comment into the student’s work 
rather than writing it anew with each paper. As these notes will be used again and again, the 
instructor is incentivized to carefully craft these comments so that they are easily understood, 
detailed, and informative. In addition to the instructor’s own thoughts, the comments can 
easily direct students to additional resources. Examples would include page number 
references to the Student Guide to Writing in the ELA (SGW), (e.g. “Avoid starting sentences 
with And, But, So. For a list of more appropriate transitions, see SGW 51”) or hyperlinks to 
online sources (e.g. “For this type of source, see the MLA citation page on the website for 
Purdue’s Online Writing Lab (OWL). For more examples of such comments, see the 
Appendix. 

The notes that are created can be organized in various ways. One way is to have a set 
of comments specific to a particular stage of the writing process. For example, it may be 
useful to have a set of notes solely for early drafts. These notes can focus on the rudimentaries 
of formatting, organizational structure, development of ideas, and resources for proper 
documentation such as in-text citations and the Works Cited page, etc. A different set of notes 
can be focused on the final draft. These can be more complementary in nature in order to 
support the student for having followed earlier feedback. It is useful as well to have various 
additional sets of notes that provide detailed instruction on any of the various issues an 
instructor might face when interacting with a student’s writing. These might include specific 
notes categorized into the following sets: grammar, punctuation, usage, tone, documentation, 
etc. For an example of a set of documentation notes, please see the Appendix. 

Another type of note, which can be included with the sets of notes focused on a stage 
of the writing process (e.g. the final draft), are summary comments. While personal in nature, 
parts of the comment will likely be common to a number of different students. An example of 
a stored summary comment for a final draft at the end of the spring term might be the 
following:  

 
Hi X,  
Good work!  
You have researched, organized, and written well, and made a good effort 
with documenting your sources. I enjoyed reading this. You still need to work 
on your ____ but you can focus on that in the fall term.  
Thanks for this essay and all of your hard work this term. Have a great 
summer! 
Ken 
 

These comments can be adapted and personalized for each student, but having a template such 
as this saves a great deal of time for the instructor yet provides students with a sense of 
personal connection to their teacher. In addition to pasting such a note as a comment in the 
student’s paper, the comment can also be included in the email notification when returning the 
paper. Google Classroom helps automate this process by allowing the instructor to paste this 
same comment as a “Personal comment” before clicking “Return.” The student will then also 
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receive the comment in an email along with the linked, returned paper, thereby helping to 
ensure the comment is seen and read.  
 
 

Conclusion 
  
 For ELA students to develop into effective and confident academic writers of English, 
both in the CLA and in study abroad programs at universities overseas, it is essential that they 
receive comprehensible, informative, and instructive feedback on their written work. This 
feedback will be provided time and again, over multiple drafts and various types of 
increasingly complex writing assignments. For writing instructors in the ELA, however, 
providing the kind of feedback that best serves students can be a labor-intensive and time 
consuming task. Particularly onerous is having to deliver the same feedback again and again 
on a great many student drafts. By drawing upon the functionality of tools within the G-Suite 
for Education, the burden can be significantly lessened. Google Classroom streamlines the 
workflow by making it very easy to assign, collect, assess, and return assignments. For 
responding directly to student drafts, the three tools within Google Docs—Preferences, Voice 
typing, and Keep notepad—make it possible to more quickly and effectively deliver common 
feedback comments.  
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Appendix 
 
Examples of sets of notes kept in Keep for use in Keep notepad. 
 
a. Comments specific to a stage in the writing process: 
 
ARW3 spring essay—1st/2nd draft comments 
 
● Formatting: Check to make sure you are doing it just like with the ARP example on 

SGW 30 (but without the "summary" and "discussion" headings): Inserted page number 
and family name aligned right in the header section, identification section just like in 
SGW, title centered and the first letter of important words capitalized, paragraphs 
indented approx. 5 spaces (just one press of the tab key), margins (2.5 cms), space 
between lines (1.5 or double spaced) 12 pt. font size. 

● Title. This is too vague—in English, you want a fairly specific title that at least hints at 
the position you are taking. 

● Thesis statement. You need one sentence at the end of your introduction that clearly 
and completely expresses the central claim (main idea) of your argument. 

● Topic sentence. You need a sentence at the beginning of this paragraph that clearly 
summarizes the main idea of the paragraph.  

● Development. This is a good point that you make, but make it stronger by providing 
specific support for what you are saying, that is, please provide specific details such as 
examples, facts, statistics, quotations from experts, etc.    

● Spelling, grammar, punctuation errors. Notice the red line underneath these words. Just 
right click on them to find and select the suggested correct form. 

● Conclusion. The key elements to include, and in this order, are 1) a restatement of your 
thesis, 2) a brief summary of your main points, 3) a closing (final thought) that provides 
a strong ending to your essay. 

● Works Cited should be on a separate page (insert page break) and be properly formatted 
(SGW 75). See SGW (70~75), the OWL website (https://goo.gl/BpznD), or use 
EasyBib (http://www.easybib.com/) for the correct forms. For Japanese sources, see 
SGW 73, #14. 

● Hi…….,  
You are doing good work! You have organized well and you are supporting your points 
nicely with research. Your documentation could still be improved, but that will be 
covered in detail in the fall term. In addition to taking my comments into account, 
continue to revisit this in the coming days, revise where you can, get some peer 
feedback, and be prepared to submit your final draft on Friday. 
Ken 
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b. Specific comments focused on a particular aspect of writing: 
 
Documentation 
 
● Family name (not given name) in a parenthetical citation. 
● In a parenthetical citation, provide the first couple of words of the title, just enough to 

find the title in your Works Cited. 
● Use the first couple of words of the title rather than the newspaper name. 
● Periods need to be after the parenthetical citation. 
● Author's name not needed if you have already given it in the same sentence. 
● Family names come first in Works Cited entries. 
● Hanging indentations are needed in a Works Cited. Use the blue indent markers in the 

ruler scale at the top of the page to indent the second (and following) line 
approximately five spaces. 

● Use capitals for the first letters of all the important words in a title. 
● Use italics for book, newspaper, magazine, and journal titles. 
● Periods are required at the end of each Works Cited entry. 
● Works Cited entries need to be in alphabetical order. 

 
 
 
 


